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Introduction 
 

Overall Learning Objectives 
The overall learning objectives for the Abstract Plus training course are 
 

• Identify the purpose and benefits of Abstract Plus. 
 

• Log in to Abstract Plus after installation. 
 

• Identify the components of Abstract Plus. 
 

• Know how Abstract Plus is set up and configured. 
 

• Import and export abstracts. 
 

• Create abstracts. 
 

• Run the available reports. 
 

• Modify abstracts. 
 

• Back up and restore data. 
 

The Abstract Plus Training Manual 
This training manual contains three chapters that will be reviewed and used during the 
training session. Each chapter focuses on a specific section or topic and provides 
requirements, explanations, instructions, and questions. 

 

Please feel free to make additional copies of the manual and share with your colleagues. 
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Abstract Plus Purpose 
Abstract Plus was developed to accomplish the following goals 

• To summarize the medical record into an electronic report of cancer diagnosis and 
treatment by abstractors and other individuals or groups who work with cancer 
data. 

 
• To support CDC's National Program of Cancer Registries. Abstract Plus supports 

all data items in national standard data sets, including text. CDC provides support 
and consultation to state central registries for their state-specific customization 
and distribution of the Registry Plus software. 

 

Abstract Plus Capability and Features 
• The output of Abstract Plus is an electronic abstract in the format of the North 

American Association of Central Cancer Registries (NAACCR) data exchange 
layout (currently NAACCR version 11). 

 
• The data set can be customized to meet local needs including locally-defined 

variables with a selection of data items and the order in which they are displayed. 
 

• The NAACCR edits are tightly integrated into Abstract Plus, allowing standard 
editing and error correction online. 

 
• Abstract Plus includes Registry Plus Online Help, a collection of standard coding 

manuals that are cross-referenced, indexed, and context-linked to minimize the 
need for reference to printed manuals during abstracting. 

 
• Abstract Plus can be distributed free of charge to cancer reporting facilities in a 

state. 
 

• Although the product is not designed to include all functionality needed in an 
approved hospital cancer registry, it is suitable for reporting from non-registry 
hospitals, clinics, laboratories, and other sources for cancer incident reports. 

 
• Abstract Plus can also be configured for special purpose data collection. 

 
• Abstract Plus has multi-cultural and multi-language options; Spanish translation is 

currently available. 
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Users 
Abstract Plus users consist of 
 

• Abstractors (CTR certified) 
 

• Central cancer registrars 
 

• Other individuals or groups who work with cancer data in hospitals, doctor’s 
offices, laboratories, etc. 

 

User Types  
 
The following table describes the two types of Abstract Plus users 
 

Users Description 

General Users General users can add, edit, and delete abstracts. They 
cannot perform administrative functions, such as setting 
up Abstract Plus configurations. 

Administrators Administrators can perform all the functions of general 
users, but have additional rights in the system. They can 
perform additional functions such as editing the display 
types and fields, or changing the user ID or password.  
An administrator password is required in order to 
perform administrative functions.  

 

User Support 
 
For user support information, refer to the Registry Plus web site at 
http://www.cdc.gov/cancer/registryplus/ap.htm. CDC supports the state central registry 
and the state central registry supports Abstract Plus users. 

 

System Requirements  
 
For user system requirements information, refer to the Registry Plus web site at 
http://www.cdc.gov/cancer/registryplus/ap.htm. 
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Installing and Accessing Abstract Plus 
 
To install and access Abstract Plus  
 

1. Link to your Internet Web Browser (i.e., Internet Explorer, Netscape, etc.) by clicking 
on the desktop icon or by clicking Start, selecting Programs, and then selecting the 
Internet Web Browser link.  

2. On the Web Browser, type in the following URL for the Registry Plus web site and 
press Enter. 

http://www.cdc.gov/cancer/registryplus/

3. Under the Registry Plus Components section, select the Abstract Plus link. 

4. Be sure to read the section “Installing and Upgrading Abstract Plus.” 

5. Under the “Installation” section, click the Download Abstract Plus to your 
Computer link. 

6. Click Download on the displayed page and follow all the prompts to download 
Abstract Plus. 

7. To access Abstract Plus, double-click the Abstract Plus icon (shown below) on your 
desktop. 

 
 

 

The system administrator or someone with administrative privileges 
to your machine will install Abstract Plus for each user.  
 
The downloaded version of Abstract Plus is a generic one. Most users 
will need a customized version of the software set up to meet the 
requirements of a specific locale, usually a state or specific study. 
Potential users of Abstract Plus should first contact their State Central 
Cancer Registry staff for their customized version and for support.  
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Chapter 1: The Basics  
Learning Objectives 
Upon the completion of this chapter, you will be able to 

 
• Log in to Abstract Plus as a guest. 

 
• Create your own user ID and password. 

 
• Log in using your own user ID and password. 

 
• Log out and use the Backup Option. 

 
• Navigate the Abstract Plus main menu. 
 

 

Overview 
The first step in using Abstract Plus is to log in to the system. The system comes pre-
loaded with a user ID and password that you can use; however, you can also create a 
unique user ID and password of your own. Creating your own user ID and password is 
particularly useful as a way to uniquely identify the user. When logged in with your own 
user ID and password, you are recorded as the abstractor. This information can be used as 
selection criteria for reports and exports, and can also be used for general tracking 
purposes to associate abstractors with their specific abstracts. When logging out of 
Abstract Plus after completing your work, the system prompts you to back up the abstract 
database. 

The Abstract Plus administrator can add as many users as necessary. The administrator 
functions will be discussed later in the training.  
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Logging In 
 
After installing Abstract Plus, you can log in as a guest using the pre-loaded user ID and 
password 
 
To log in to Abstract Plus as a guest 

1. From the Start menu, select Programs and select Abstract Plus. 

2. Select AbsPlus to display the User ID window. 

Result: The pre-loaded user ID information is pre-selected, if no other users have 
been added.  

 

 

If other users have been added, you will not be able to create your 
own user ID. Select user DOE and consult the Administrator to create 
your user name. 

 

 
 

3. Type guest in the Password field. Notice that the system does not display the 
password, but displays asterisks instead. Passwords are not case sensitive.  
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4. Click Cancel.  

Result: The Abstract Plus system closes. 
 

 

When logging in as a guest, you would click OK, but for the purpose 
of this training, you will be creating your own user ID and password. 
 
Abstract Plus Help is available by clicking  whether or not 
you log in to the system. 
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Creating a New User ID 
 

 
You can create a user ID for yourself using the AP1 method only 
once. If multiple users already exist in the system, i.e. the pre-
loaded user and the one you set up, the system disables the AP1 
user ID and you can no longer create a user. The administrator can 
create as many users as necessary. 

 
To create your own user ID and log into Abstract Plus 

1. Access the Abstract Plus login window. 

2. Type AP1 in the USER ID field. 

Result: The Edit User ID/Password window opens. Notice that the current user is 
identified in the Current User ID field as AP1. The same user ID is also displayed at 
the bottom right-hand of the window. 
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3. Click  on the upper right-hand side of the window for detailed help information. 

 

 

 
You do not have to log into the system to access the Help pages. 

 

4. Click Add New and type your name in the User Name text field highlighted. 

5. Tab to the User ID field and type your initials in the User ID text box. 

6. Tab to the next field and type your chosen password in the Enter Password field. 

7. Press Enter. 

Result: The system changes the Enter Password field to Confirm Password. 

8. Confirm the password by typing it in the Confirm Password field. 

9. Press Enter. 

Result: The system adds the new user ID to the users list. 

10. Select the user ID you just created and select Change Current User. 

Result: The system displays the name and ID in the appropriate fields, and focuses 
on the Password text box. 

11. Type your newly-created password and press Enter. 

Result: The system displays you as the new current user. 

12. Click Close to close the Edit User ID/Password window and display the Abstract Plus 
main menu. 
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Logging Off Abstract Plus 
When logging off Abstract Plus, the system prompts you to back up the current abstract 
data. 
 
To log off Abstract Plus 

1. In the Abstract Plus menu, select File and choose Exit.  

Result: The system prompts you to confirm that you want to exit the system. 

 
2. Click OK to confirm that you want to exit Abstract Plus. 

Result: A prompt appears, asking you if you want to back up your work.  

 

 
 

 
Although you can choose otherwise, it is strongly recommended 
that you back up all the work you have done during an Abstract 
Plus session. 

 

3. Click Yes. Notice that you can also choose not to back up your work. 

Result: A dialog box appears. 
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4. Accept the default location for saving the backup file by clicking OK. 

 

 

 
You can navigate to wherever you please to save the backup file. 

 

Result: A window used in the backup process opens. 

 
 

5. Click Next. 

Result: Another window used for the backup process opens. This window confirms 
all the options you selected for backing up the file. 
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6. Click Finish. 

Result: The system saves the information in a zip file and displays a confirmation 
message. 

 
7. Click OK to close Abstract Plus. 

8. Log into Abstract Plus again. 
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Abstract Plus Main Menu 
 
The Abstract Plus main menu is made up of menu options that allows you to carry out all 
the available tasks. Some menu options are also available as buttons in the toolbar as 
shown below. 
 

 
 
The following tables describe the menu options. 
 
File 
 

Use this menu option… To… 
New Abstract Create a new abstract.  

This option is also available on the toolbar as . 
Open/Find Abstract… Find and display information for an existing 

abstract.  

This option is also available on the toolbar as . 
Copy Abstract… Copy an existing abstract.  

This option is also available on the toolbar as . 
Close Abstract Close an open abstract.  

This option is also available on the toolbar as 

. 
Save Abstract… Save abstract information.  

This option is also available on the toolbar as . 
Export Abstracts… Export abstract(s) from Abstract Plus into a 

NAACCR layout text file.  

This option is also available on the toolbar as . 
Import Abstract in 
NAACCR Format… 

Import abstract(s) from a NAACCR layout text file 
into the Abstract Plus database. This option is also 
available on the toolbar as . 

Printer Setup… Display a dialog box for printer options.  
Print Current Abstract Preview the displayed abstract before printing it. 

This option is also available on the toolbar as . 
Print Range of 
Abstracts… 

Select and send a range of abstracts to a printer or 
save in a file. 

Restore… Restore the database. Replace corrupted database 
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with previously saved backup. 
Exit Log off Abstract Plus with an option to back up the 

database with your work.  
 
Administration (password protected options) 
 

Use this menu option… To… 
Projects… Edit the project names in Abstract Plus.  
Critical Fields… Edit the critical fields for a project in Abstract Plus. 
Display Types… Edit display type names.  
Display Fields… Edit display fields for a display type.  
User ID/Password… Edit user ID and/or password.  
Administrator’s 
Password… 

Edit the administrator’s password.  

System Configuration… Select preferences and edits for a configuration 
name.  

Delete Current 
Abstract… 

Delete the currently displayed abstract. 

 
Utilities 
 

Use this menu option… To… 
Batch Completion Re-
check (Unexported 
Abstracts) 

Check the completion count in unexported abstracts. 

Registry Query System Disabled option from previous versions. 
Doctor Query System Query and search the database of local physicians. 

DQS can be accessed whether or not there is an 
active abstract or a physician field selected.  
This option is also available on the toolbar as 

. 
Import Data into RQS Disabled option from previous versions. 
Notepad Launch Notepad to view created text files. 

 

  14 



Abstract Plus Training Manual  The Basics 

Reports 
 

Use this menu option… To… 
Accession Register Preview the Accession Register report before 

printing it.  
Patient Index Preview the Patient Index report before printing it. 
Selected Cases… Select specific cases and preview a report listing the 

cases selected before printing it. 
Status Report (Count of 
Cases) Summary… 

Enter a date range and preview a report showing the 
totals of complete and incomplete records before 
printing it. 

Completion Status of 
Abstracts by Month… 

Enter a date range and preview a report breaking 
down the status of incomplete and complete records 
within the specified date range before printing it.  

 
Help 
 

Use this menu option… To… 
Contents… View the contents the Abstract Plus Help. 
Search for help on… Enter text for which you need more information. 
About View version information for Abstract Plus. 
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Questions 
 

1. Can you log into Abstract Plus without creating a user ID and password? How? 

 

2. Why is it important to create your own user ID and password? 

 

3. Do you have to log into Abstract Plus to use the online Help? 

 

4. When logging off Abstract Plus, how can you ensure that the work you did during the 
session is secure and safe? 
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Chapter 2: Setting up and Configuring Abstract 
Plus 
Learning Objectives 
 

Upon the completion of this chapter, you will 

 
• Have a general idea of how Abstract Plus is set up and configured by the 

Administrator. 
 

• Understand critical missing fields and projects. 
 

• Understand display fields and display types. 
 

• Know the options available with system configuration. 
 

Overview 
This section gives a general idea of the functions available under the Administration 
menu (shown below) and describes how the administrator sets up display types and edit 
sets, and configures the system. 
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When selected, functions under the Administration menu require an administrator 
password in the Administrator’s Password window. The system displays the window only 
once during an Abstract Plus session. After entering the password, the administration 
functions become available throughout the session. 

 

 
 

Projects  
All abstracts must be attached to a project. The administrator adds, maintains, and deletes 
projects from the Projects option on the Administration menu. All projects created are 
available to the users from the abstracting screen. Multiple projects may be assigned to an 
abstract.  

 

Critical Missing Fields 
Critical missing fields are fields for which a user is required to enter a value, for a 
specific project. If data is missing from a critical missing field, the system displays an 
error when running EDITS and marks the abstract as incomplete. The administrator sets 
up critical missing fields. This feature can be accessed using the Critical Fields option on 
the Administration menu.  

 

Display Types 
Display types are used to define the order and properties of fields displayed for an 
abstract. The administrator adds, maintains, and deletes display types. This function is 
accessed through the Displays Types option under the Administration menu. The 
administrator assigns a display type to a configuration. The user can select an available 
configuration from the abstracting screen.  
 
Display types set the fields displayed or shown on the abstract data entry screen and offer 
the administrator the flexibility to specify the fields that a user can see. For example, the 
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administrator can set a display type that allows you to see only 10 fields which are 
relevant to the data being entered in one location, and set another display type that allows 
you to see 50 fields which include additional fields entered in another location. 
 

Display Fields 
The administrator assigns display fields to display types and properties set using the 
Display Fields Selection window. Properties set for a field include, invisible (used in 
edits but not displayed), protected (value displayed but unable to change) and default 
value (initial value of field).  This window can be accessed using the Display Fields 
option under the Administration menu. 
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 Configuring Abstract Plus 
 
The administrator configures the system using the System Configuration option under the 
Administration menu. The System Configuration window is used to create, maintain, and 
delete different sets of configurations, and has the following three tabs: EDITS Options, 
Preferences, and Configuration. The configurations created by the administrator can be 
selected from the abstracting screen to change the view and choices available for an 
abstract. 
 
Configuration 
 
The administrator uses the Configuration tab, shown below, to define display types, edit 
sets, and collaborative staging for a configuration. When working with an abstract, you 
can change configurations by simply selecting another available configuration from the 
Configuration drop-down list. The last used configuration becomes the default for a 
newly opened abstract until you change it. 
 

 
 
 

 

Unlike the choices in the EDITS options and Preferences tabs that are 
generally changed upon login only, choices in the Configuration tab 
become immediately visible in the abstracting screen when the 
configuration name is changed.  
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EDITS Options 
 
The administrator uses the EDITS Options tab, shown below, to set the parameters for 
EDITS, the program that checks abstracts for errors. The tab displays the selected edit set 
and display type. The administrator can click Configure Individual Edits to further set 
up more edit options for each edit in the edit set. 
 
The configuration of the options allows maximum flexibility. The administrator can 
specify exactly which edits are to be run against your data and the conditions under 
which they will run.  
 

 
 
 

 

Changes to the EDITS options are not immediate; they are visible the 
next time the user logs into the system with this configuration name 
set as the default. 
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Preferences 
 
The administrator uses the Preferences tab, shown below, to control functions such as 
automatically filling the abstractor ID, setting the default database and backup 
database/restore folders, calculating the age of a patient at time of diagnosis, etc. These 
options are normally the same for all configurations. 
 

 
 
 

 

Changes to the Preferences tab are not immediate; for the most part, 
they are visible the next time the user logs into the system with this 
configuration name set as the default. 
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Managing Users 
The User ID/Password option under the Administration menu displays the Edit User 
ID/Password window that allows the administrator to add and delete users in a location 
and also change the password of users.  
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Changing the Administrator’s Password 
 
An administrator’s password can be changed using the Administrator’s Password option 
under the Administration menu. This option displays the Administrator’s Password 
window where the administrator can check or change the password.  
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Questions 
 
1. How do critical missing fields affect the completion of an abstract? 

 
2. What flexibility do Display Types offer? 

 
3. What program checks abstracts for errors? 

 
4. What takes effect immediately when the configuration is changed? 
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Chapter 3: Working with Abstracts 
Learning Objectives 
Upon the completion of this chapter, you will be able to 

 
• Import abstracts into Abstract Plus. 

 
• Identify the areas in the Abstract Plus abstracting screen. 

 
• Create a new abstract. 

 
• Modify an abstract. 

 
• Copy an abstract. 

 
• Correct errors in an abstract. 

 
• Export abstracts. 

 
• Print a range of abstracts. 

 
• Use the Notepad Function (Utilities). 

 
• Use the Help to find out more information about fields. 

 
• Back up and restore abstracts. 

 
• Run reports. 
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Overview 
 

You can start working with abstracts by 

• Importing abstracts in NAACCR format from any system in an ASCII text file. 

• Creating a new abstract. 

• Copying an existing abstract and saving it as a new one. 

An existing abstract can be modified and the changes saved. Abstracts in an ASCII text 
file can also be exported in NAACCR format to any other system. 
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Importing an Abstract 
You can import abstracts in NAACCR format from any system into Abstract Plus if they 
are contained in an ASCII text file.  

 

Import and Open an Abstract Practice Activity 
Purpose 
 

• Import abstracts. 
 

• Use the online Help for further information and assistance. 
 

• Open a selected abstract. 
 
To import abstracts 

1. Click  on the toolbar. 

Result: The Import Abstracts in NAACCR Format window opens. 
 

 
 

2. Click Select Import File. 

Result: The system displays a Windows Explorer dialog box where you can select a 
file. 
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3. Navigate to AbsPlus\Utilities\v11data.DAT. Abstract Plus comes pre-loaded with this 
file. 

Result: The system populates the fields in the dialog box with the information in the 
selected file, such as the number of abstracts in the file and the NAACCR abstract 
type. Notice the Import Log button on this window. This button lets you see the 
history of the abstracts you have imported. 

 

 
 

4. Click  to display the Help for the window and learn more about the fields. 

5. Click Import. 

Result: The system imports the abstracts and displays a confirmation message at the 
bottom of the window. 

6. Click Import Log. 

Result: The system displays information about the data that has been imported, the 
name of the abstractor, number of abstracts, and file name. 
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7. Click Close to close the Import Log, and Close again to close the Import window. 

8. Click  on the toolbar. 

Result: The system displays the Search Abstract pop-up window with the Name field 
highlighted. 

9. Press Enter. 

Result: The system displays all the available abstracts. Notice that you can sort all 
the abstracts by simply clicking on each heading. For example, you can sort the list 
by date diagnosed, sex, vital status (is patient dead or alive?), abstract number, etc. 

 
 

10. Click Atarms,Sargent,U and click Select to display and view this abstract.  
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Result: The system displays an error message informing you that the abstract you are 
about to open contains errors. 

11. Click OK. 

Result: The selected abstract opens in the Abstract Plus abstracting screen described 
in the next section. Notice that the Edits tab on the right displays the first error found 
in the abstract. 
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The Abstract Plus Abstracting Screen 
 
Abstract Plus is made up of three main areas: displayed fields, field entry/selection area, 
and additional tab information. Within each of these are several sections where specific 
information can be entered and maintained. The table below lists the main areas in the 
abstracting screen. 
 
 

Abstracting Screen 

Displayed Fields Field/Entry Selections Additional Tab 
Information 

• Abstract 
Sections 

• Display Type 
• Configuration 

name 
• Field Title 
• Field Value 

• Current Value 
• Select New Value 
• Field Context 

Help 

• Text Fields 
• Edits 
• Edit Info 
• Projects 
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Use the Field Entry/Selections area 
to enter, view, select, and erase the 
values for a field, and also view the 
field context Help. 

Use the Displayed Fields area to 
select the configuration which 
defines the fields displayed on the 
screen, the edit set used for 
correction and other options, and to 
navigate to the fields for editing.  

Use the Additional Tab 
Information area to enter additional 
text, view error messages from 
EDITS, attach an abstract to a 
project(s), and view the completion 
status of the abstract. 
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Creating a New Abstract  
Use the New Abstract option under the File menu to create a new abstract, or simply 
click  on the toolbar. The system automatically assigns a number to new abstracts and 
increments the number by one as new abstracts are created. 

 

Create Abstract Practice Activity 
Purpose 
 

• Enter information for a new abstract. 
• Use the online Help for further information and assistance. 

 
To create an abstract 

1. Click  on the toolbar. 

Result: The system displays an abstract with blank fields. Notice that the abstract has 
been assigned a number, the first display field is highlighted, and a blinking cursor is 
present in the Current Value field. 
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2. Type Jones as the last name in the Current Value field. 

 
3. Press Enter. Notice that you can also click OK. 

Result: Jones appears in the Field Value column next to the Last Name field. Notice 
that the next field is now highlighted and the Current Value field is selected for that 
field.  

 
4. Type Ellen in the Current Value field and click OK. 

Result: Ellen appears in the Field Value column next to the First Name field. Notice 
that the Middle Name field is now highlighted and the Current Value field is blank 
again. 

 
5. Click the DXState field. 

Result: A list of states appears in the Select New Value field. 

6. Start typing Georgia. Notice that the system displays the full name of the state in the 
Current Value field even before you finish typing. Press Enter. 

Result: The next field is now highlighted. 

7. In the Abstract Sections drop-down list, select Patient Demographics. 

Result: All fields belonging to the Demographic section are highlighted, and the first 
field in the group is selected for entry. 

8. With the BPCode field selected, type USA in the Select New Value field, and press 
Enter. 

Result: An error message appears, informing you that the value entered is not valid. 

9. Click OK to close the error message pop-up. Notice that the error is also displayed in 
the fields in the Edit tab. 
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10. Click the Edit Info tab to view more information about the error. 

11. Click  next to the Field Context Help. 

Result: The Help information for the specific field appears. 

12. Close the Help page and select the BPCode field. 

13. Press [F4] to view the valid values for the BPCode field. 

14. Type United States in the Search field. 

Result: The system highlights United States in the list even before you finish typing. 

 
15. Press Enter to select the highlighted item. 

Result: The system populates the Current Value field with 000, which is the code for 
United States, displays 000 in the BPCode field, and selects the next field. 

16. Navigate to the PhysFup field.  

17. Select the field and press [F4]. 

Result: The system displays a query pop-up window for you to select a doctor. 

18. Type JO in the Name field and click Query. 

Result: The system displays a list of doctors whose last names begin with “Jo.” 

19. Double-click on the doctor ID for James Jones to select that doctor. 

Result: The Query pop-up window closes, the doctors’ ID appears in the Current 
Value field, and the system selects the next field. 
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Questions 
1. What are the three ways that you can use to start working with abstracts? 

 

2. What are the three main areas of Abstract Plus? 

 

3. How does an ID get assigned to an abstract? 

 

4. Which feature allows you to view valid values for a field? 
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 Entering Information into Text Fields  
Text fields are used for entering additional information. The text fields are divided into 
the DX, RX, and Misc. tabs. 

 

Entering Information into Text Fields Practice Activity 
Purpose 
 

• Enter text into the DX, RX, and Misc. text fields. 
• Use the online Help for further information and assistance. 

 
To enter text in text fields 

1. Select the Text Fields tab. 

2. Under the DX tab, select PE and type the following text in the Abstract Text box. 

Abd DISTENDED.DULL TO PERCUSSION.MASS PALPATED IN UPPER 
ABD 

Result: A progress bar under the Abstract Text area displays the percentage of space 
the text you just entered has used up. 

3. Use the down arrow to navigate to Histology Title and type the following text in the 
Abstract Text box. 

PAPILLARY ADENCA GR2 
Result: The progress bar under the Abstract Text area displays 50% and the system 
displays an asterisk (*) beside PE to indicate that you have entered PE information. 

4. Click the RX tab, select Chemo, and type the following text in the Abstract Text box. 

12/17/96 THIOTEPA 8/16/97 CISPLAT, CTX 

Result: An asterisk appears beside DX to indicate that text exists in some fields under 
the DX tab. The status bar under the Abstract Text area displays 19%. 

5. Click the Misc. tab, select Remarks, and type the following text in the Abstract Text 
box. 

PLACED ON SUPPRESSIVE TRX WITH SYNTHYROID TO SEE 
WHETHER THIS NODULE WOULD REGRESS 
Result: An asterisk appears beside RX to indicate that text exists in some fields under 
the RX tab. The status bar under the Abstract Text area displays 23%. 
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Correcting Errors 
 

For a new abstract, you can view the errors for an incorrect field entry, when you save the 
abstract, or when you click the EDITS button. 

 

Correct Errors Practice Activity 
 

Purpose 
 

• Display errors in the abstract. 
• Correct errors in the abstract. 

 
To view and correct the errors in the abstract 

1. Click  on the Abstract Plus tool bar. 

Result: A pop-up window informs you that the abstract has errors. 

 
2. Click OK to close the pop-up window and automatically display the Edits tab.  

Result: An error is already selected in the Edits tab, in this case DX-City. Notice that 
the number of critical missing fields in the abstract is also displayed. 
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3. Click the Edit Info tab and view the description for the error. In this case, there is no 

description available. 

4. Click Edit Description button on the Edits tab to view the description for the error. 
In this case, there is no description available. 

 

 

The information in the Edit Info tab is the same information 
displayed when you click Edit Description. Viewing the error 
information using the Edit Description button lets you remain on the 
Edits tab and at the same time see the description of the error. 

 

5. With the first error still selected, type Atlanta in the Current Value field and press 
Enter. 

Result: Atlanta now appears in the DX-City field and the next entry field is 
highlighted. 

6. Click  on the Abstract Plus tool bar. 

Result: The corrected error field no longer appears on the list, another error is 
highlighted. Notice that the number of errors has decreased by one. 
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Saving an Abstract  
You can save your abstract at any time, even with critical fields missing information. 
However; the system will not mark such abstracts as complete. You can return at a later 
time to correct the errors and complete the abstract. 

Save Abstract Practice Activity 
 

Purpose 
 

• Accept the errors in the project, if any. 
• Save the abstract. 

 
To save an abstract 

1. Click  on the toolbar. 
Result: The system displays the following error message informing you that errors 
are present in the abstract. 
 

 
 

2. Click Yes, Save to save the abstract. 
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Questions 
1. How do you know how much data a text field can take? 

 

2. How do you know that an abstract contains errors? 

 

3. Which tab do you use to correct errors in an abstract? 

 

4. How do you know how many errors exist in an abstract? 

 

5. Can you save an abstract that has errors? 
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 Assigning an Abstract to a Project  
An abstract must be assigned to a project. If only one project exists in Abstract Plus, the 
system automatically assigns the abstract to the sole project. However, if several projects 
exist, the system prompts you to assign the abstract to a project when you are in the 
process of saving the abstract. You can assign an abstract to a project as described in this 
section.   

 

Assign Project Practice Activity 
Purpose 
 

• Select a project and assign the abstract to the project. 
 
To assign an abstract to a project 
1. Select the Projects tab. 

Result: A list of projects to which you can assign the abstract appears. 
2. Select State in the Select a Project list box. 
3. Select Close Abstract.  
4. Click Yes, Save to save the abstract and return to the main menu. 

 

 

You can also use this tab to see if the abstract is complete and indicate 
if the abstract should be held by the abstractor, meaning that the 
abstract will not be available for export. 
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Modifying an Abstract  
You can make changes to an abstract in Abstract Plus by simply opening the abstract and 
updating and saving the abstract. 

Modify Abstract Practice Activity 
 

Purpose 
 

• Open a saved abstract. 
• Modify the fields in the abstract. 
• Save the abstract. 

 
To modify an abstract 

1. Click  on the toolbar. 
Result: A Search Abstract pop-up window opens. 

2. Type JO in the Name field and click Query. 
Result: Ellen Jones appears in the list of results. 
 

 
 

3. Select Jones, Ellen and click Select. 
Result: The system displays an error message informing you that the abstract 
contains errors. 

4. Click OK. 
Result: The selected abstract appears. 
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5. Click the FirstName field and click Erase Current Value. 
Result: The system removes Ellen from the Current Value field. 

6. Type Helen in the Current Value field, and click OK. 
7. Click the DXCounty field, type Cobb in the Current Value field and click OK. 
8. Close and save the abstract and follow the prompts. 
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Copying an Abstract  
If you find an abstract that looks very much like an abstract you want to create, for 
example, the same patient but with a different diagnosis, you can simply save the abstract 
as a new one, and then modify the necessary fields in the new abstract.  

 

Copy Abstract Practice Activity 
 

Purpose 
 

• Open a saved abstract. 
• Copy the abstract. 
• Modify the abstract. 

 
To copy an abstract 
1. Search for Sargent Atarms’ abstract and open the abstract. 
2. From the File menu, select Copy Abstract. 

Result: A pop-up window opens and displays the old abstract number and the 
number assigned to the new abstract. 
 

 
 
3. Click OK. 

Result: The new abstract takes the place of the old abstract. 
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4. Click the LastName field, type Williams in the Current Value field, click OK. 
5. Click the FirstName field, type Jack in the Current Value field and click OK. 
6. Close and save the abstract. 
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Questions 
 
1. Can an abstract exist without being attached to a project? 

 
2. How can you locate a saved abstract? 

 
3. Can you change the information contained in an existing abstract? 

 
4. How can you create an abstract using the information from an old one? 
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 Exporting Abstracts  
When exporting abstracts, you can choose to export all abstracts, including complete and 
incomplete abstracts, or enter parameters for selecting the completed abstracts for export. 
The system can be set up to make the feature for including complete or incomplete 
abstracts during export a function that must be set up only by the administrator. The 
option Mark Exported Abstracts as Off-Loaded is selected by default and should not be 
changed except for special reasons. Export Only Un-Exported Abstracts To Date is also 
selected by default.  

You can export abstracts in NAACCR Layout or Delimited format, depending on options 
made available by the administrator. The Delimited format allows you to select which 
fields you want exported and their order in a pipe delimited text file.  

Refer to Exporting Abstracts Help for detailed explanation of export selection options. 

 

Export Abstract Practice Activities 
Purpose 
 

• Export all abstracts. 
• Enter parameters for exporting abstracts. 
• Export selected abstracts. 

To export all the abstracts in the database 

1. Click  on the toolbar. 

Result: The Export Abstracts window opens. 
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2. Select the Export All Abstracts in Database check box. 

 

 
The Export All Abstracts in Database function may only be 
available to administrators. 

 

3. De-select the Mark Exported Abstracts As Off-Loaded check box. This ensures that 
the abstracts you are about to export are not flagged or marked as exported. 

4. Click Select. 

Result: The system indicates the number of abstracts that meet the criteria at the 
bottom of the window. 

5. Click Preview.  

Result: The Export Selection Preview window appears 
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6. Click OK. 

Result: A windows dialog box appears. 
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7. Type firstexport in the File Name field and click Save. 

Result: The system saves the abstracts into a text file and lets you preview a report 
that you can print.  

 

 
 

 

You can click  at the top right of the screen to open a dialog box 

and print the report. You can click  to print the contents of the 
report to a file, such as .htm or .txt. To enlarge or decrease the size 
of the file, select the percentage of enlargement from the Zoom 
drop-down list. To navigate from one page of the report to another, 
use the arrows at the bottom left-hand side of the screen. 

 

8. Close the report preview and return to the Export Abstracts window. 

9. Click Export Log to view the log of exported abstracts. 

Result: The Export Log window opens. Notice that you can enter a date range or 
enter Select Case ID, and click Select to view exports that contain the specified 
values. 

10. Click Show All Exports to view all exports in log. 
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11. Click Close to return to the Export Abstracts window and Close to return to the main 
menu. 
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To export only selected abstracts 

1. Click  on the toolbar. 

Result: The Export Abstracts window opens. 

 
 

 

The Export Only Un-Exported Abstracts To Date check box is 
selected. This ensures that exported abstracts are not duplicated. 

 

2. Select the Export by Date Created (Entered) check box. 

3. In the From field type 10/01/2005, and in the To field, type 10/30/2005. This ensures 
that only the abstracts created within the entered dates will be exported. The Mark 
Exported Abstracts As Off-Loaded check box is selected. This ensures that the 
abstracts you are about to export are flagged. 

 

 

 
You can also select abstracts by the date previously exported, date 
diagnosed, hospital ID, project ID, abstractor ID, and abstract ID. 
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4. Click Select. 

Result: The system indicates that no abstracts meet the criteria, at the bottom of the 
window. 

5. Close the Export Abstracts window. 
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Printing a Range of Abstracts 
You can select one or more abstracts from your local database and print them. You can 
even choose to print the abstracts to a text file instead of sending them directly to a 
printer. 

Print Range of Abstracts Practice Activity 
Purpose 
 

• Enter the criteria for selecting abstracts. 
• Print the abstracts to file. 

 

To print a range of abstracts 

1. Click the File option on the Abstract Plus menu and select Print Range of Abstracts... 

Result: The Print Abstracts window opens. 

 
2. Select the All Abstracts in Database check box. 
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You may select or de-select any number of criteria options by 
clicking on them if the All Abstracts in Database check box is not 
selected. If the last selected option cannot be logically combined 
with certain previously selected options, the system automatically 
de-selects the earlier options. 
 

 

3. Click Select. 

Result: The system displays the number of abstracts that meet the selected criteria at 
the bottom of the window. 

4. Click Generate Text File. 

Result: The system generates a text file containing all the abstracts selected. The 
location of the file, prtfile.txt, is indicated at the bottom of the window above the 
number of abstracts.  
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Be sure to take note of the location of this file. You will need this 
information in the next activity. 

 

5. Close the criteria selection window. 
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Using the Notepad Function (Utilities)  
The Notepad program is integrated into Abstract Plus under the Utilities menu. Notepad 
allows you to view the contents of a file using the Notepad program without having to 
navigate away from Abstract Plus. 

Notepad Function Practice Activity 
Purpose 
 

• Access a previously saved text file containing abstracts. 
• Open the text file using the Notepad function in Abstract Plus. 

 

To view the abstracts in a text file 

1. Click the Utilities option from the Abstract Plus menu and select Notepad. 

Result: The Notepad program opens. 

2. Click File on the Notepad menu and select Open. 

Result: A windows dialog box opens. 

3. Navigate to the folder into which the system saved prtfile.txt, the file you created in 
the Print Range of Abstracts practice activity. 

 

 
4. Open the text file. 

Result: The selected file opens in Notepad. 
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5. View the contents of the file and close Notepad. 
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Restoring Data  
The Restore function in Abstract Plus is extremely useful when something goes wrong 
with your data. Rather than having to start from scratch, you can go back to a file that you 
saved with the same Abstract Plus version on a date when you encountered no problems. 
This is one reason why it is recommended that you back up your work when shutting 
down the system. 

Restoring Data Practice Activity 
Purpose 
 

• Access a previously saved backup file. 
• Replace the current data with the backup file. 

To restore data 

1. On the Abstract Plus menu, click File and select Restore… 
Result: The Restore AbstractPlus Database window opens. 
 

 
 

2. Click Browse. 
Result: A window that you can use to navigate to the backup file opens. 
 

 

 
You can also type the path to the backup file that you want to use for 
the restore. 

 
3. Navigate to and select absplus.zip. This is the same file that you saved the first time 

you logged off the system at the beginning of this training session. 
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4. Click Open. 
Result: The system closes the window and redisplays the Restore AbstractPlus 
Database window. Notice that the path to the restore file now appears in the text box. 
 

 
 

5. Click Restore. 
Result: A confirmation window appears. 
 

 
 

6. Click OK to close the window. Restored database must be in the same NAACCR 
layout as the current one or an error message will appear. 
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Questions 
 
1. How can you avoid exporting duplicate abstracts? 

 
2. How can you see all the abstracts you exported? 

 
3. How can you print multiple abstracts at the same time? 

 
4. What is the main benefit of the Notepad integration feature? 

 
5. How do you recover data in Abstract Plus if for any reason your data becomes 

corrupted? 
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 Running Reports  
Abstract Plus contains several reports that you can run to view data. The available reports 
are described in the table below. 

 
Report Description 

Accession Register Displays all the abstracts in the database sorted by 
reporting hospital and accession number. 

Patient Index Displays all the abstracts in the database sorted by name.

Selected Cases Displays only the specific cases you selected as criteria. 

Status Report (Count 
of Cases) 
Summary… 

Displays the total number of complete and incomplete 
records, cross tabulated by the number of records 
exported and unexported. 

Completion Status of 
Abstracts by month 

Displays a detailed report breaking down the complete 
and incomplete status of abstracts by year and month of 
Date of Adm/1st Contact. This report can be used to 
monitor work activity and to identify the oldest 
incomplete cases for priority attention.  

 

 

To run custom reports, you can use MS Access querying and 
reporting from the database outside of Abstract Plus. 
 

For each report, you can click  at the top right of the report to 

open a dialog box and print the report or click  to print the 
contents of the report to a file, such as .htm or .txt. To enlarge or 
decrease the size of the report, select the percentage of enlargement 
from the Zoom drop-down list. To navigate from one page of the 
report to another, use the arrows at the bottom left-hand side of the 
report. 
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Running Reports Practice Activity 
Purpose 
 

• Run each report in Abstract Plus. 
• View the contents of each report. 

Accession Register Report 
To run the Accession Register report 

1. Click Reports on the Abstract Plus menu and select Accession Register. 

Result: The Accession Register report opens. Notice that the accession numbers are 
displayed in ascending order and grouped by the reporting hospital. Abstracts with no 
accession numbers are displayed at the top of the report. 

 

 
 

Report displays according to 
accession number. 

2. Close the report. 
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Patient Index Report 
To run the Patient Index report 

1. Click Reports on the Abstract Plus menu and select Patient Index. 

Result: The Patient Index report opens. Notice that the abstracts are displayed in 
alphabetic order by the name. 

 

 

Report displays according 
to last name. 

2. Close the report. 
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Selected Cases Report 
To run the Selected Cases report 

1. Click Reports on the Abstract Plus menu and select Selected Cases. 

Result: The system displays a window to enter report criteria. 

 
2. In the Abstract ID field, type 1 in the first text box and 5 in the second text box to 

display abstracts with IDs that fall into the specified range and click Query.   

Result: The system displays the cases that meet the entered criteria in the space 
below the fields. 
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You can choose to display all available abstracts by simply pressing 
Enter when the cursor is in the Name field. You can enter report 
criteria such as the medical record number, social security number, 
etc. You can also choose to display complete, incomplete, or all 
abstracts (complete and incomplete). 

 

3. Click Run Report. 

Result: The report opens in print preview mode. Notice that it displays only the cases 
that fall within the specified range. The system also records and displays the SQL 
statement used to create the report at the top of the report. 
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4. Close the report print preview and the criteria selection windows. 
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Status Report (Count of cases) Summary 
To run the Status Report (Count of cases) Summary report 

1. Click Reports on the Abstract Plus menu and select Status Report (Count of cases) 
Summary… 

Result: The system displays a window where you enter criteria for displaying the 
report. 

 
2. Select the Select All Cases in Database check box to select and include all cases in 

the report. 

Result: The report opens and displays the summary information for the abstracts. 
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3. Close the report and the criteria selection window. 
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Completion of Abstracts by Month 
To run the Completion of Abstracts by Month report 

1. Click Reports on the Abstract Plus menu and select Completion of Abstracts by 
Month. 

Result: The system displays a window where you enter criteria for displaying the 
report. 

 
2. Select the Select All Cases in Database check box to select and include all cases in 

the report. 

Result: The report opens and displays the number of complete and incomplete 
abstracts. 

 
 

3. Close the report and the criteria selection window. 
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Questions 
 
1. How can you list only the incomplete abstracts from a certain hospital? 

 
2. How can you create custom reports? 
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Appendix: Answers 
Chapter 1 
 
Here are the answers to the questions on page 16 about the basics of Abstract Plus. 

 

1. Yes, you can log into Abstract Plus without creating a user ID and password. 
You can log in as a guest. 

 

2. Creating and using your own user ID and password automatically identifies 
which abstracts you create. 

 

3. No, you do not have to log into Abstract Plus to use the online Help. You can 
access the online Help from the login window.  

 

4. When logging off Abstract Plus, use the backup option to save your work to a 
secure location.  

 
 
Chapter 2 
 
Here are the answers to the questions on page 25 about setting up and configuring 
Abstract Plus. 

 
1. Fields identified as critical must be completed before the abstract can be saved 

and marked as completed. 
 
2. Display Types allow the administrator to set up the system to display only 

certain fields.  
 
3. EDITS checks the abstracts for errors and can include local customized 

corrections. 
 
4. The display type (fields displayed), edit set used for error correction, and 

collaborative staging calculation choices take effect immediately when the 
configuration is changed. 
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Chapter 3 
 
Here are the answers to the questions on page 37 about importing and creating an 
abstract. 

 

1. You can start working with abstracts by importing, creating, or copying 
abstracts.  

 

2. The three main areas of Abstract Plus are Field Entry/Selections, Displayed 
Fields, and Additional Tab Information. 

 

3. The system automatically assigns IDs to abstracts.  

 

4. When valid values are available for a list, [F4] displays a pick list and allows 
you to view the valid values for the field. 

 
Here are the answers to the questions on page 42 about entering information into text 
fields, correcting errors, and saving an abstract. 

 

1. The percentage of use is displayed at the bottom of the Abstract Text area as 
you type. 

 

2. When you save the abstract or click the EDITS button on the tool bar, the 
errors are displayed in the Edits tab. 

 

3. The Edits tab displays the errors in the abstract and allows you to navigate to 
the fields needing correction. 

 

4. The error count is displayed on the Edits tab and also in the bottom left-hand 
panel of the screen when you run Edits. 

 

5. Yes, you can save an abstract that has errors. The abstract is marked as 
incomplete. 
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Here are the answers to the questions on page 48 about assigning abstracts to a project, 
modifying an abstract, and copying an abstract. 

 
1. No, the system will not save an abstract that is not attached to a project. 

However, If only one project exists, the system will choose it by default and 
attach the abstract to the sole project.  
 

2. Locate a saved abstract by selecting the Open/Find Abstract option under the 
File menu or clicking the Open/Find Abstract button on the tool bar. 
 

3. Yes, you can change the information contained in an existing abstract. Access 
the abstract, update the information, and click the Save button on the tool bar.  
 

4. Use the Copy Abstract option under the File menu to copy the abstract, and 
then edit the fields as needed.  

 
Here are the answers to the questions on page 63 about exporting an abstract, printing a 
range of abstracts, using the Notepad feature, and restoring data. 
 

1. Select the following check boxes in the Export Abstracts window:  
• Mark abstracts as offloaded 
• Export only un-exported Abstracts to date 

 
2. Click the Export Log button on the Export Abstracts window for a detailed 

export history.  
 

3. Select Print Range of Abstracts from the File menu.  
 

4. The integrated Notepad feature gives you the ability to view the contents of a 
file without leaving Abstract Plus. 
 

5. Select the Restore option under the File menu and use a backup file created 
with the same Abstract Plus version.  

 
Here are the answers to the questions on page 73 about running reports. 

 
1. Run the Selected Cases report. 
 
2. Use MS Access querying and reporting from the database outside of Abstract 

Plus.  
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